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Subject: Computer

Duration (Periods): 2

Lesson Name: Evolution of Computers 

Overview: Early counting devices were used to perform simple arithmetic calculations, 
however, the advancements in technology led to the enhancement of existing computers 
and other such devices.

Prior Knowledge: The students have basic knowledge about computers.

Learning Outcomes:
At the end of the lesson, the student will be able to: 

	• identify various calculating devices.
	• understand the generations of computers. 

Teaching Aids: 
	• https://i.pinimg.com/564x/4d/3b/e1/4d3be1a509271084cb589a9a08509c44.jpg

	• https://ohiostate.pressbooks.pub/graphicshistory/chapter/1-1-early-analog-
computational-devices/

Learning Segments:

LESSON LINK
Time: 05 minutes

Purpose: Brief 
introduction/discussion to 
pique students’ interest.

Greet the class and introduce the topic:
	• Counting has been a basic need since ancient times, 

with early humans using various tools such as sticks, 
stones and bones for this purpose.

	• Computers have a long history, and over time, they 
have undergone significant improvements in terms of 
size, accuracy, and speed to enhance their performance.

LESSON EXECUTION
Time: 25 minutes

Purpose: Engagement of 
both teacher and students 
to achieve the learning 
outcomes.

Period 1
	• Introduce the various early counting devices such 

as abacus, Pascaline Adding Machine, Leibniz Step 
Reckoner, Analytical Engine and Tabulating machine.

	• Discuss the different generations of computers and 
the advancements that they brought.

	• Use placards to show the pictures of different devices 
in the class.

Period 2
	• Read out the rubrics in the Skill Drill section and 

encourage the students to indulge in the task 
individually.

	• Ensure that each student has completed the task.

1.  Evolution of Computers
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DigiVerse 54

LESSON CLOSURE
Time: 05 minutes

Purpose: Summarising the 
key points and reinforcing 
the learning outcomes of 
the lesson.

	• Discuss the answers to the questions.
	• Recapitulate the topics discussed in the lesson.

Answer Key [Chapter 1]

A.	 Tick () the correct option.
1.  c. Analytical Engine		  2.  a. microprocessors			   3.  a. evolution
4.  c. Lady Ada Lovelace		 5.  a. UNIVAC

B.	 Fill in the blanks using the words in the box.
1.	 Abacus			   2.	 calculator		  3.  1951			   4.  5200
5.	 Laptops

C.	 Write T for True and F for False statements.
1.	 F			   2.	 F		  3.  F			   4.  F
5.	 F

D.	 Answer the questions in a few words.
1.	 The full form of GUI is Graphical User Interface.
2.	 Some features of a smartphone are:

•	 A smartphone is user-friendly.
•	 Smartphones have a touchscreen interface.
•	 Smartphones are lightweight and small in size.

3.	 The Leibniz Step Reckoner was created by Gottfried Wilhelm Leibniz.
4.	 Pascaline Adding Machine is the world’s first calculator. It had four wheels for 

entering numbers to add or subtract.
5.	 UNIVAC was invented by Presper Eckert and John Mauchly.

E.	 Answer the following questions.
1.	 First-generation computers are those computers that used vacuum tubes. These 

computers were huge and had limited programming abilities. First-generation 
computers operated in machine language.

2.	 Harvard Mark-I is the first electro-mechanical powered computer, developed by 
Professor Harward Aiken on 7th August 1944. It used punched cards for input and 
typewriter for output.
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Subject: Computer

Duration (Periods): 2

Lesson Name: Word 2016: Advanced Features

Overview: Word 2016 offers various tools to insert and modify the text.

Prior Knowledge: The students have worked on Word 2016.

Learning Outcomes:
At the end of the lesson, the student will be able to: 

	• use Thesaurus in Word 2016.

	• format the page, column and paragraph.
	• use the Mail Merge feature.

Teaching Aids: 
	• https://support.microsoft.com/en-gb/office/video-check-spelling-and-grammar-

8a55148a-bfef-4290-87f7-5898b825b719

	• https://edu.gcfglobal.org/en/word/page-layout/1/

Learning Segments:

LESSON LINK
Time: 05 minutes

Purpose: Brief 
introduction/discussion to 
pique students’ interest.

Greet the class and introduce the topic:
	• When working in Word 2016, errors like misspelled 

words, extra spaces, or the absence of spaces can 
occur as we type. 

	• In Word, we can detect and correct these errors 
without having to manually review the entire text.

2.  Word 2016: Advanced Features

3.	 An abacus was the first-ever computing tool. It is made of a wooden frame with 
colourful beads on sticks that run side by side. It is used to do basic calculations 
such as adding and subtracting numbers.

4.	 The features of third-generation computers are:
•	 The computers were smaller, more powerful and energy-efficient.
•	 Integrated circuits boosted processing speed and power.
•	 Computer networks allowed remote data access.
•	 Magnetic disk drives became common for faster data storage.
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DigiVerse 56

LESSON EXECUTION
Time: 25 minutes

Purpose: Engagement of 
both teacher and students 
to achieve the learning 
outcomes.

Period 1
	• Demonstrate the steps to use the various editing 

tools such as Thesaurus, Find and Replace.
	• Also, discuss the ways to format paragraphs and 

columns in Word.
	• Demonstrate the steps to use the Mail Merge feature.

Period 2
	• Read out the rubrics in the Skill Drill section and 

encourage the students to indulge in the task 
individually.

	• Ensure that each student has completed the task.

LESSON CLOSURE
Time: 05 minutes

Purpose: Summarising the 
key points and reinforcing 
the learning outcomes of 
the lesson.

	• Discuss the answers to the questions.
	• Recapitulate the topics discussed in the lesson.

Answer Key [Chapter 2]

A.	 Tick () the correct option.
1.	 a. Synonyms	 2.	 b. blue	 3.	 a. Mailings tab	 4.	 b. Paper Size
5.	 c. Spelling & Grammar

B.	 Fill in the blanks using the words in the box.
1.	 Spell Check	 2.	 Layout	 3.	 Orientation	 4.	 formatting
5.	 Data source

C.	 Write T for True and F for False statements.
1.	 F	 2.	 T	 3.	 F	 4.	 F
5.	 T

D.	 Answer the questions in a few words.
1.	 The three main steps of mail merge are:

•	 Creating the main document: It is the letter that you want to send to people.
•	 Creating the data source: It is the list of recipients who will receive the main 

document.
•	 Merging documents: It refers to combining the main document and the data source.

2.	 The steps to use the Thesaurus tool are: 
•	 Select the word that you wish to replace.
•	 Go to the Review tab and click on the Thesaurus tool from the Proofing group.
•	 Right-click on any word and select the Insert or Copy option from the Thesaurus 

pane.
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3.	 We can identify the errors in a document by using the Spelling & Grammar tool.
4.	 Paragraph spacing is the vertical space between paragraphs.
5.	 Page formatting is the arrangement of text and other elements on a page in a 

manner that makes it appear organized and appealing to the reader.

E.	 Write the steps for the following.
1.	 The steps to change the page orientation are:

•	 Click on the Layout tab.
•	 Select the Orientation command in the Page Setup group.
•	 Choose your preferred orientation—Portrait or Landscape.

2.	 The steps to find text are:
•	 Click on the Home tab.
•	 Click on the Find tool in the Editing group. 
•	 Type the word that is to be found and press the Enter key. That word will appear 

highlighted in the document as many times as it has occurred.
•	 Click on Results to go to that search item in the document.

3.	 The steps to insert a page break are:
•	 Click on the Layout tab.
•	 Click on the Breaks command in the Page Setup group.
•	 Select the Page option. A page break will be inserted in the document.

4.	 The steps to replace text are:
•	 Click on the Home tab.
•	 Click on the Replace tool in the Editing group. A Find and Replace dialog box 

will appear. The Replace tab is selected by default.
•	 Type the word that you want to search and replace.
•	 Type the alternate word that you want it replace it with, in the Replace with box.

5.	 The steps to change the layout of the text into columns are:
•	 Select the text that you want to layout into columns.
•	 Click on the Layout tab.
•	 Select the Columns command in the Page Setup group.
•	 Select the number of columns from the drop-down menu. The selected text will 

appear in columns.
6.	 The steps to create the main document are:

•	 Type the letter in Word.
•	 Click on the Mailings tab.
•	 Click on the Start Mail Merge option in the Start Mail Merge group. A 

drop-down menu will appear.
•	 Select the Letters option from the menu.
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Subject: Computer

Duration (Periods): 2

Lesson Name: PowerPoint 2016: Formatting Presentation

Overview: PowerPoint is used to make presentations.

Prior Knowledge: The students know the basic usage of PowerPoint.

Learning Outcomes:
At the end of the lesson, the student will be able to: 

	• apply theme in PowerPoint 2016.

	• insert SmartArt.
	• use the animation feature and apply slide transitions.

Teaching Aids: 
	• https://hr.uw.edu/pod/wp-content/uploads/sites/10/2016/07/handout-PPTtipsFINAL.pdf

	• https://support.microsoft.com/en-us/office/add-and-format-in-powerpoint-for-the-web-
191d948c-3759-48d6-b3fc-8dfce24bdfab

Learning Segments:

LESSON LINK
Time: 05 minutes

Purpose: Brief 
introduction/discussion to 
pique students’ interest.

Greet the class and introduce the topic:
	• PowerPoint 2016 is used to create presentations.
	• We can use various features to enhance the 

presentations.

LESSON EXECUTION
Time: 25 minutes

Purpose: Engagement of 
both teacher and students 
to achieve the learning 
outcomes.

Period 1
	• Explain the meaning of themes, animations and 

transitions.
	• Demonstrate the steps to change the theme and 

background.
	• Demonstrate the steps to add SmartArt, animations 

and transitions.

Period 2
	• Read out the rubrics in the Skill Drill section and 

encourage the students to indulge in the task 
individually.

	• Ensure that each student has completed the task.

3.  PowerPoint 2016: Formatting Presentation
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LESSON CLOSURE
Time: 05 minutes

Purpose: Summarising the 
key points and reinforcing 
the learning outcomes of 
the lesson.

	• Discuss the answers to the questions.
	• Recapitulate the topics discussed in the lesson.

Answer Key [Chapter 3]

A.	 Tick () the correct option.
1.	 c. Both a and b	 2.	 c. Both a and b	 3.	 c. Advanced animation
4.	 b. Illustrations	 5.	 a. Slide Navigation Pane

B.	 Fill in the blanks using the words in the box.
1.	 Animations	 2.	 order	 3.	 Design	 4.	 transition
5.	 Customize

C.	 Write T for True and F for False statements.
1.	 T	 2.	 F	 3.	 F	 4.	 T
5.	 F

D.	 Define the following categories of animation.
1.	 Entrance animations can change/beautify the entry of text or an object.
2.	 Emphasis animations can highlight the select point/object from the slide.
3.	 Exit animations can change/beautify the exit of text or an object.
4.	 Motion Paths animation defines the path/pattern in which the selected text or 

object will move on the screen.
5.	 By using With Previous, the animation begins at the same time as specified in the 

previous animation.

E.	 Answer the following questions.
1.	 Slide transitions are used to make the next slide appear seamlessly (without any 

gap). It makes the presentation much better because the slides appear in a smoother 
manner. The display of one slide after the other is known as transition.

2.	 SmartArt is a visual representation of data in a different format such as Cycle, 
Process, Lists, Hierarchy, Relationship, Matrix, Pyramid and Picture.

3.	 Animations are special visual effects that can be added to text or other elements 
on a slide. It helps to enhance presentation. We can set the time, and sequence 
for each animation that we add to the presentation.

4.	 PowerPoint provides ready-made themes to apply to the slides. Themes are used 
to make the presentation look better and more professional.

5.	 We can remove an animation by clicking on the number in front of the object/text 
which is animated. The number box will appear highlighted, we can then press the 
Delete key. An animation can also be removed from the Animation Pane. Click on 
an effect and press the Delete key.
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Subject: Computer

Duration (Periods): 2

Lesson Name: Using Excel 2016

Overview: Excel is an electronic spreadsheet that is used to organise data/information in 
rows and columns.

Prior Knowledge: The students have basic mathematical skills and knowledge about tables.

Learning Outcomes:
At the end of the lesson, the student will be able to: 

	• understand the components of Excel 2016 window.
	• create a new workbook.

	• enter data in a worksheet.

	• save, open and close a workbook.

Teaching Aids: 
	• https://www.youtube.com/watch?v=tuk99Sgc6Fw

	• https://support.microsoft.com/en-us/office/create-a-new-workbook-ae99f19b-cecb-
4aa0-92c8-7126d6212a83

Learning Segments:

LESSON LINK
Time: 05 minutes

Purpose: Brief 
introduction/discussion to 
pique students’ interest.

Greet the class and introduce the topic:
	• Excel is used to create worksheets.
	• It is a great tool for data organisation.

LESSON EXECUTION
Time: 25 minutes

Purpose: Engagement of 
both teacher and students 
to achieve the learning 
outcomes.

Period 1
	• Explain the meaning and usage of the components of 

the Excel window.
	• Demonstrate the steps to create, save and open a 

workbook.
	• Demonstrate the steps to enter the data, rename a 

worksheet and add a worksheet.

Period 2
	• Read out the rubrics in the Skill Drill section and 

encourage the students to indulge in the task 
individually.

	• Ensure that each student has completed the task.

4.  Using Excel 2016
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LESSON CLOSURE
Time: 05 minutes

Purpose: Summarising the 
key points and reinforcing 
the learning outcomes of 
the lesson.

	• Discuss the answers to the questions.
	• Recapitulate the topics discussed in the lesson.

Answer Key [Chapter 4]

A.	 Tick () the correct option.
1.	 a. Cell	 2.	 b. alphabets	 3.	 b. insert function	 4.	 c. spreadsheet
5.	 a. Shift + Enter

B.	 Fill in the blanks using the words in the box.
1.	 active	 2.	 numbers	 3.	 columns	 4.	 Status
5.	 Sheet

C.	 Write T for True and F for False statements.
1.	 F	 2.	 T	 3.	 F	 4.	 T
5.	 F

D.	 Write the function for the following keys.
1.	 Ctrl + End keys move the active cell to the last cell on the worksheet.
2.	 Ctrl + Home keys move the active cell to the first cell, i.e. A1.
3.	 Tab key moves the active cell one column to the right.
4.	 Shift + Enter keys move the active cell one row up.
5.	 The left arrow key moves the active cell one column to the left.

E.	 Answer the following questions.
1.	 Title Bar: It is located at the top of the Excel window. It displays the name of the 

current workbook and the name of the program. Minimize, Maximize/Restore Down 
and Close buttons are also located on the right side of the Title bar.

	 Ribbon: It is just below the Title bar. It consists of various tabs which are divided 
into groups. There are command tools and buttons in the groups.

2.	 A worksheet is also known as a spreadsheet. It consists of cells in which we can 
enter data and perform various functions. 

	 An Excel file is known as a workbook. It consists of several worksheets. The default 
name of a new workbook is Book1. A new workbooks consists of one worksheet 
known as Sheet1.

3.	 The vertical sections are known as columns and the horizontal sections are known 
as rows. Excel has 1,048,576 rows and 16,384 columns which allow the user to store 
a lot of data in a worksheet.
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4.	 The steps to open a workbook are:
•	 Click on the File tab.
•	 Select the Open option from the left pane. The Open dialog box will appear. 
•	 Click on the Browse option and navigate to the folder where the workbook is 

saved.
•	 Type a name in the File name box.
•	 Click on the Open button.

5.	 Excel is an electronic spreadsheet that is used to organise data/information in rows 
and columns. Some features of Excel are:
•	 Excel features a user-friendly interface with the Ribbon, which organizes the 

commands into tabs and groups for easy access.
•	 Users can create and manage spreadsheets with ease.
•	 It offers a wide range of built-in formulas and functions for mathematical, 

statistical, financial and logical calculations.
•	 We can perform data analysis like sorting, filtering and creating tables to gain 

insights from the data.

5.  Excel 2016: Editing

Subject: Computer

Duration (Periods): 2

Lesson Name: Excel 2016: Editing

Overview: Excel is used to create spreadsheets in which we can enter and modify the data.

Prior Knowledge: The students have basic knowledge of Excel.

Learning Outcomes:
At the end of the lesson, the student will be able to: 

	• change cell contents.

	• use Undo and Redo commands.

	• copy and move data.

	• delete cell contents.
	• use the AutoFill feature.

Teaching Aids: 
	• https://www.tutorialspoint.com/computer_concepts/computer_concepts_editing_

worksheet_data.htm

	• https://www.simplilearn.com/tutorials/excel-tutorial/excel-worksheet
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Learning Segments:

LESSON LINK
Time: 05 minutes

Purpose: Brief 
introduction/discussion to 
pique students’ interest.

Greet the class and introduce the topic:
	• Excel is an electronic spreadsheet that is used to 

organise the data. 
	• Excel has various features that we can use to modify 

the data entered in the cells.

LESSON EXECUTION
Time: 25 minutes

Purpose: Engagement of 
both teacher and students 
to achieve the learning 
outcomes.

Period 1
	• Demonstrate the steps to select a cell, row, column, 

range of cells or an entire worksheet.
	• Demonstrate the steps to enter the date and time.
	• Explain the meaning and usage of Undo and Redo 

commands.
	• Demonstrate the steps to copy the data, move the 

data, delete the cell contents and use the AutoFill 
feature.

Period 2
	• Read out the rubrics in the Skill Drill section and 

encourage the students to indulge in the task 
individually.

	• Ensure that each student has completed the task.

LESSON CLOSURE
Time: 05 minutes

Purpose: Summarising the 
key points and reinforcing 
the learning outcomes of 
the lesson.

	• Discuss the answers to the questions.
	• Recapitulate the topics discussed in the lesson.

Answer Key [Chapter 5]

A.	 Tick () the correct option.
1.	 c. fill handle	 2.	 b. A1:B3	 3.	 c. Active	 4.	 c. worksheet
5.	 b. double clicking

B.	 Fill in the blanks using the words in the box.
1.	 Ctrl + Shift + ;	 2.	 Redo	 3.	 editing	 4.	 Cell address
5.	 range

C.	 Write T for True and F for False statements.
1.	 T	 2.	 F	 3.	 T	 4.	 T
5.	 F
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D.	 Answer the questions in a few words.
1.	 We use the formula bar to change the cell contents. We can double-click on the 

formula bar and enter the new values.
2.	 The AutoFill feature in Excel is used to fill a series of data in rows and columns 

automatically.
3.	 We can delete the contents of a cell by following these steps:

•	 Select the cell or range of cells to delete.
•	 Click on the Home tab.
•	 Click on the Delete button from the Cells group. Select the Delete cells option 

from the Delete drop-down menu. A dialog box will appear with four options.
•	 Click on the option that you prefer.
•	 Click on the OK button.

4.	 We can select a range of cells in two ways:
•	 Using the mouse: Click on the top left cell and drag the mouse pointer to the 

bottom right cell that you want to select. The range will appear highlighted as 
we drag the mouse to the last cell that we want to select.

•	 Using the keyboard: Click on the first cell from the range that you want to select. 
Then, press the Shift key and click on the last cell from the range of cells that 
you want to select.

5.	 The steps to copy the data are:
•	 Select the cells that you want to copy.
•	 Click on the Home tab.
•	 Click on the Copy button from the Clipboard group. You can also use the 

keyboard shortcut Ctrl + C to copy the selected image.
•	 Click on the cell where you want to copy the selected range.
•	 Click on the Paste button in the Clipboard group. You can also use the keyboard 

shortcut Ctrl + V to paste the copied item.

E.	 Write the keyboard shortcuts for the following functions in Excel.
1.	 Ctrl + V	 2.	 Ctrl + A	 3.	 F2	 4.	 Ctrl + C

6.  Internet and E-mail

Subject: Computer

Duration (Periods): 2

Lesson Name: Internet and E-mail

Overview: E-mail is used to send and receive messages from various users across the world.

Prior Knowledge: The students are aware of e-mails.
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Learning Outcomes:
At the end of the lesson, the student will be able to: 

	• differentiate between the types of Internet connections.

	• identify the components of an e-mail.

Teaching Aids: 
	• https://www.careerera.com/cyber-security/post-graduate-program-in-cyber-security

	• https://i.pinimg.com/originals/02/7c/aa/027caa91d3cd898dd674660a112ab39a.jpg

Learning Segments:

LESSON LINK
Time: 05 minutes

Purpose: Brief 
introduction/discussion to 
pique students’ interest.

Greet the class and introduce the topic:
	• The Internet is a web of millions of computers, all 

connected from around the world.
	• It can be used to exchange information.

LESSON EXECUTION
Time: 25 minutes

Purpose: Engagement of 
both teacher and students 
to achieve the learning 
outcomes.

Period 1
	• Explain the meaning of Internet and the requirements 

of an Internet connection.
	• Discuss the different types of Internet connections.
	• Demonstrate the steps to use web browsers and 

URLs.
	• Explain the meaning and advantages of e-mail.
	• Demonstrate the steps to create an e-mail account.
	• Demonstrate the steps to sign in, sign out, send and 

read an e-mail.

Period 2
	• Read out the rubrics in the Skill Drill section and 

encourage the students to indulge in the task 
individually.

	• Ensure that each student has completed the task.

LESSON CLOSURE
Time: 05 minutes

Purpose: Summarising the 
key points and reinforcing  
the learning outcomes of  
the lesson.

	• Discuss the answers to the questions.
	• Recapitulate the topics discussed in the lesson.
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Answer Key [Chapter 6]

A.	 Tick () the correct option.
1.	 b. Airtel	 2.	 b. network of networks	 3.	 a.  Piyush@gmail.com
4.	 c. Inbox	 5.	 c. Both a and b

B.	 Fill in the blanks using the words in the box.
1.	 websites	 2.	 broadband	 3.	 network	 4.	 address
5.	 e-mail

C.	 Write T for True and F for False statements.
1.	 F	 2.	 T	 3.	 F	 4.	 T
5.	 F

D.	 Answer the following questions.
1.	 The three main components of an e-mail address are:

•	 Username: This part can be your choice, such as your name or the name of your 
business, but it has to be unique.

•	 @: An email address can’t be complete without this symbol, and it’s pronounced 
as ‘at.’

•	 Domain Name: This is the web address that comes after the ‘@’ symbol, 
indicating the email service provider or organisation. For example: Google, 
Yahoo, etc.

2.	 The steps to use URLs are:
•	 Type the URL in the address bar of the browser.
•	 Press the Enter key from the keyboard.

3.	 We can connect to the Internet through various ways. The types of Internet 
connection are:
•	 Dial-up connection: A dial-up connection needs users to link their computer to 

a phone line to go online. But, when they are connected, they cannot make or 
receive phone calls at the same time.

•	 Wi-Fi means Wireless Fidelity. It uses radio signals to link to the Internet. To go 
online wirelessly, we need a modem, but we don’t need a physical cable.

4.	 The requirements for an Internet connection are:
•	 Device: You need a device such as a computer, smartphone, tablet or smart TV 

that can connect to the Internet.
•	 Internet Service Provider (ISP): You must have a contract or subscription with 

the Internet Service Provider. The ISP is the company that provides you with the 
access to the Internet. ISPs offer various types of connections including DSL, 
cable, fiber-optic and wireless.

•	 Modem: This device connects your computer or router to the Internet service 
provided by your ISP.
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•	 Router: A router is necessary if you want to share your Internet connection with 
multiple devices such as computers, smartphones, and tablets.

•	 Network cable: You will need a network cable to connect your device to the 
modem or router if you are using a wired connection.

•	 Software: You need a web browser or apps for specific online services to access 
and navigate the Internet.

5.	 Electronic mail, commonly referred to as e-mail, is a digital message that can be 
transmitted from one computer user to others through a network.

Subject: Computer

Duration (Periods): 2

Lesson Name: Data Processing

Overview: Learning to organise data to make it meaningful.

Prior Knowledge: The students are familiar with the concept of sorting.

Learning Outcomes:
At the end of the lesson, the student will be able to: 

	• understand the meaning of data and information.

	• recognise the ways of representing data.

	• understand the decoding of a message.

Teaching Aids: 
	• https://www.liveworksheets.com/w/en/english-second-language-esl/800413

	• https://teachsimple.com/product/noun-sorting-worksheet

Learning Segments:

LESSON LINK
Time: 05 minutes

Purpose: Brief 
introduction/discussion to 
pique students’ interest.

Greet the class and introduce the topic:
	• Data means raw and unorganised information. 
	• The data becomes information when we process it, 

which involves organising and managing the raw data 
to create a final, useful output.

7.  Data Processing
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LESSON EXECUTION
Time: 25 minutes

Purpose: Engagement of 
both teacher and students 
to achieve the learning 
outcomes.

Period 1
	• Explain the meaning of sorting and decoding.
	• Discuss the different ways to represent information.
	• Use placards to show the tables, maps, pictures, map, 

pictograms, etc.

Period 2
	• Read out the rubrics in the Skill Drill section and 

encourage the students to indulge in the task 
individually.

	• Ensure that each student has completed the task.

LESSON CLOSURE
Time: 05 minutes

Purpose: Summarising the 
key points and reinforcing 
the learning outcomes of 
the lesson.

	• Discuss the answers to the questions.
	• Recapitulate the topics discussed in the lesson.

Answer Key [Chapter 7]

A.	 Fill in the blanks using the words in the box.
1.	 Data		  2.	 coded		  3.	 Sorting

B.	 Decode the following words.
1.	 RUST		  2.	 POND		  3.	 BOWL		  4.	 GAP

C.	 Answer the questions in a few words.
1.	 The final output that is derived after organizing and managing the raw data is 

known as information.
2.	 Sorting means arranging the data by their category or type. It becomes much easier 

to understand and identify the data when it is sorted properly. 
3.	 Decoding is the process of simplifying a coded message and understanding its 

meaning.

Subject: Computer

Duration (Periods): 2

Lesson Name: Conditional Blocks in Scratch

Overview: Scratch is a free programming software.

Prior Knowledge: The students are aware of different types of games.

8.  Conditional Blocks in Scratch
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Learning Outcomes:
At the end of the lesson, the student will be able to: 

	• understand various shapes of blocks in Scratch.

	• use Sensing blocks.

	• create variables.

	• create games or scripts using conditional blocks.

Teaching Aids: 
	• https://scratchprogrammingforkids.com/wp-content/uploads/Maze-Game-on-Scratch-

3.0-Tutorial.png.webp

	• https://i.pinimg.com/564x/26/39/2c/26392c08b96c40b4e823993f2b40d70e.jpg

Learning Segments:

LESSON LINK
Time: 05 minutes

Purpose: Brief 
introduction/discussion to 
pique students’ interest.

Greet the class and introduce the topic:
	• Scratch is used to create different games.
	• It is used to introduce programming to students in an 

easy way.

LESSON EXECUTION
Time: 25 minutes

Purpose: Engagement of 
both teacher and students 
to achieve the learning 
outcomes.

Period 1
	• Discuss the different shapes of blocks in Scratch.
	• Explain the meaning and usage of Sensing blocks.
	• Discuss the meaning of variables and conditional 

blocks.
	• Demonstrate the steps to create a game using 

different blocks.

Period 2
	• Read out the rubrics in the Skill Drill section and 

encourage the students to indulge in the task 
individually.

	• Ensure that each student has completed the task.

LESSON CLOSURE
Time: 05 minutes

Purpose: Summarising the 
key points and reinforcing 
the learning outcomes of 
the lesson.

	• Discuss the answers to the questions.
	• Recapitulate the topics discussed in the lesson.
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Answer Key [Chapter 8]

A.	 Tick () the correct option.
1.	 c. C blocks	 2.	 b. Boolean	 3.	 a. string	 4.	 a. if…then
5.	 c. Hat

B.	 Fill in the blanks using the words in the box.
1.	 Reporter	 2.	 Blocks	 3.	 numerical	 4.	 stack
5.	 data

C.	 Write T for True and F for False statements.
1.	 T	 2.	 T	 3.	 F	 4.	 T
5 .	 F

D.	 Answer the questions in a few words.
1.	 Boolean blocks are used for conditions in a script. They give an output as either 

true/false or 0/1 based on how they are used in a script.
2.	 Reporter blocks are used to provide a value. These blocks cannot be used alone 

because these blocks provide information for the other blocks to use. These blocks 
can contain numbers or text and have rounded edges.

3.	 A script is made up blocks which are instructions or the commands for the Sprite 
in Scratch.

4.	 Variables are used to store the data. The numbers, text or pictures that we use in 
a program are called data. The value of a variable can be changed, it is not fixed. 

5.	 Variables are of two types: Numeric and String.

E.	 Answer the following questions.
1.	 The steps to add Sensing blocks to a script are:

•	 Click on the Sensing block category in the Code tab.
•	 Insert a Sprite on the stage.
•	 Add a new backdrop.
•	 Drag the ask block to the script and place it inside the say block.
•	 Click on the checkbox before the answer block from the Sensing blocks category. 
•	 Run the script to display the answer.

2.	 The steps to create a variable in Scratch are:
•	 Click on the Variables block category. A set of bocks will appear in the block 

palette.
•	 Click on the Make a Variable block. A New Variable dialog box will appear. Type 

a variable name in the New variable name textbox.
•	 Click on the For all sprites option if you want this variable to be the same for 

the sprites. You can also click on the For this sprite only option if you want to 
use the variable for the current sprite.

•	 Click on the OK button.
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3.	 Two types of Sensing blocks are:
•	 The touching color block runs a specific set of blocks if the sprite comes into 

contact with the colour specified in the block. If not, it will execute a different 
set of blocks.

•	 The key pressed block will run the next set of blocks only of the user presses the 
specified key. If the key is not pressed, it will execute a different set of blocks.

4.	 There are two types of conditional blocks in Scratch:
•	 if…then block: When a condition is true, the blocks inside the conditional block 

will be executed. If the condition is false, the blocks inside the conditional 
blocks will not be executed. Instead, only the blocks outside the conditional 
block will run.

•	 if…then…else block: If the condition is true, the blocks inside the conditional 
block will run. But if the condition is false, then the set of blocks inside the ‘else’ 
condition will be executed.

	 For instance, imagine you want to play with your friends but you cannot find your 
ball. In this situation, there are two conditions: 

	 You’ll search for a ball. If you find the ball, you can play with your friends. If you 
can’t find the ball, then you won’t be able to play with your friends. Alternatively, 
you can ask someone to help you find it. 

    if

      ball is found
    then

        can play with friends

    if

      ball is not found
    then

        cannot play with friends 

    else

        ask someone for help

9.  Smart Devices

Subject: Computer

Duration (Periods): 2

Lesson Name: Smart Devices

Overview: Advancement in technology has led to the development of various smart devices.

Prior Knowledge: The students are familiar with artificial intelligence.
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Learning Outcomes:
At the end of the lesson, the student will be able to:

	• understand the concept of  smart homes.

	• identify the smart devices.

	• recognise the benefits of smart homes.

Teaching Aids:
	• https://i.pinimg.com/originals/ce/c9/0d/cec90d31190f24cb282c1829828e927d.jpg

	• https://graphicriver.img.customer.envatousercontent.com/files/241063969/
Business-1430-prw.jpg?auto=compress%2Cformat&q=80&fit=crop&crop=top&max-
h=8000&max-w=590&s=d77265ea8eb6e1db8b2a11849b678a5c

Learning Segments:

LESSON LINK
Time: 05 minutes

Purpose: Brief 
introduction/discussion to 
pique students’ interest.

Greet the class and introduce the topic:
	• Smart homes is a concept that involves using specific 

devices in our homes to make our living experience 
better. 

	• To create a smart home, we need an Internet 
connection and AI devices.

LESSON EXECUTION
Time: 25 minutes

Purpose: Engagement of 
both teacher and students 
to achieve the learning 
outcomes.

Period 1
	• Discuss the meaning of artificial intelligence.
	• Explain the meaning of various smart devices used in 

homes.
	• Use placards to show the pictures of various smart 

devices.

Period 2
	• Read out the rubrics in the Skill Drill section and 

encourage the students to indulge in the task 
individually.

	• Ensure that each student has completed the task.

LESSON CLOSURE
Time: 05 minutes

Purpose: Summarising the 
key points and reinforcing 
the learning outcomes of 
the lesson.

	• Discuss the answers to the questions.
	• Recapitulate the topics discussed in the lesson.
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Answer Key [Chapter 9]

A.	 Tick () the correct option.
1.	 b. smoke detectors	 2.	 a. doorbell	 3.	 c. Siri

B.	 Fill in the blanks using the words in the box.
1.	 light	 2.	 smart TV	 3.	 doorbell

C.	 Write T for True and F for False statements.
1.	 F	 2.	 T	 3.	 T	 4.	 T

D.	 Answer the questions in a few words.
1.	 Two smart devices are: Smart TV, Smart cameras
2.	 A smart doorbell is very useful as it is an advanced doorbell that can send 

notifications to the owner’s smartphone or electronic devices when a visitor 
arrives. 

3.	 A smart speaker is used for performing many tasks. It is a speaker with a virtual 
assistant that can understand voice commands and perform tasks independently.

Worksheet 1

A.	 Define the following.
1.	 Thesaurus is a collection of words that can be used to replace a selected word in 

the document. It displays a list of synonyms for the word that needs to be replaced.
2.	 Orientation of a page refers to the way in which the information will be displayed 

on the page. This information can be a text or an image that can be displayed in 
a landscape or portrait orientation. The default page orientation is Portrait.

3.	 Electronic Numerical Integrator and Computer (ENIAC) was the first general-purpose 
digital computer.

4.	 Universal Automatic Computer (UNIVAC) had the capability to process both numeric 
and textual data. It had 5200 vacuum tubes.

5.	 A page break means that a page will end and another page will be added as 
instructed by the user.

B.	 Write the steps in brief.
1.	 Text selection > Layout > Page Setup group > Columns
2.	 Mailings > Start Mail Merge group > Select Recipients > Type a New List > OK 
3.	 Layout > Page Setup group > Size > A4
4.	 Home > Editing group >  Replace > Find and Replace > Find Next > Replace All
5.	 Review > Proofing group >  Spelling & Grammar > Change All/Ignore All > OK

C.	 Application-based questions.
1.	 Mukul will find the alignment options in the Proofing group in Word 2016.
2.	 Sudha can use the Spelling & Grammar feature to correct the spellings.
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Worksheet 2

A.	 Define the following.
1.	 SmartArt is a visual representation of data in a different format such as Cycle, 

Process, List, Hierarchy, Relationship, Matrix, Pyramid and Picture.
2.	 A worksheet is also known as a spreadsheet. It consists of rows and columns. The 

rows are indicated by row headers on the left side of the workspace in the form of 
numbers. The columns are indicated by column headers on top of the workspace 
in the form of alphabets.

3.	 The cell address is unique to every cell and it is made up of a combination of row 
header and column header. 

4.	 Undo command is used to erase the last change that we made to the worksheet. 
We can click on the Undo button in the Quick Access Toolbar to use this feature.

5.	 Animations are special visual effects that can be added to text or other elements 
on a slide. It helps to enhance the presentations.

B.	 Write the steps in brief.
1.	 File > Open > Browse > File name > Open
2.	 Design > Customize group > Format Background > Fill effects
3.	 Enter data > Select cells > Home > Editing group > Fill > Series > OK
4.	 Select cells > Home > Clipboard group > Copy > Active cell > Clipboard group > 

Paste
5.	 Sheet Tab > Right-click > Rename > Enter

C.	 Application-based questions.
1.	 We can use the SmartArt option in PowerPoint to visually represent the data.
2.	 We click on the Insert tab to add visual effects in PowerPoint.

Worksheet 3

A.	 Define the following.
1.	 Sorting means arranging the data by the category or type. It becomes much easier 

to understand and identify the data when it is sorted properly.
2.	 Hotspots give us Internet access at specific places. They use Wi-Fi technology, which 

lets other devices like computers and smartphones link to the Internet through 
them.

3.	 Bcc stands for Blind Carbon Copy. By typing an e-mail address in this field, the 
recipient will know that you have sent the e-mail but the other recipients in the To 
field will not be able to know that a mail has been sent to the recipient in Bcc field.

4.	 A router is necessary if you want to share your Internet connection with multiple 
devices, such as computers, smartphones and tablets. It allows for a Wi-Fi connection 
within your home or office.
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B.	 Write the steps in brief.
1.	 Create account button > Fill personal details > Next > Fill phone number > Next >  

Terms and Conditions > I agree 
2.	 Compose button > New Message window > Write the message > Send
3.	 E-mail account icon > Sign out 
4.	 Inbox > Click on the e-mail

C.	 Application-based questions.
1.	 Ramesh will use the Bcc feature to send the e-mail.
2.	 I will use the To field for project and branch manager, whereas Cc field for CEO.

Worksheet 4

A.	 Define the following.
1.	 A smart doorbell is an advanced doorbell that can send notifications to the owner’s 

smartphone or other electronic devices when a visitor arrives.
2.	 C blocks are shaped like the letter C and are also known as wrap blocks. These 

blocks are used for creating loops that check if a condition is true for the blocks 
inside the loop.

3.	 A smart speaker is a speaker with a virtual assistant that can understand voice 
commands and perform tasks independently. Some well-known smart speakers 
include Amazon Echo, Google Nest, etc.

4.	 A script is made up of blocks, which are the instructions or commands for the Sprite 
in Scratch.

5.	 Hat blocks are shaped like hats, and they need to be added before any other block. 
Because these blocks are at the top, no other block can be added above them. 

B.	 Write the steps in brief.
1.	 Code tab > Sensing > Drag the block to the script
2.	 Code tab > Variables > Make a Variable block >  New variable name > OK

C.	 Application-based questions.
1.	 CAP blocks are the final blocks and we cannot add any more blocks after them.
2.	 Hat blocks are at the top of the script and no other blocks can be put above them.

Test Paper 1

A.	 Tick () the correct option.
1.	 c. Lady Ada Lovelace	 2.	 a. Mailings tab	 3.	 c. Both a and b
4.	 a. Shift + Enter		  5.	 c. active

B.	 Fill in the blanks.
1.	 Status		  2.	 order	 3.	 range
4.	 Layout		  5.	 1951
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C.	 Write T for True and F for False statements.
1.	 F	 2.	 F	 3.	 F	 4.	 T
5.	 F

D.	 Answer the questions in a few words.
1.	 The Leibniz Step Reckoner is a digital mechanical calculator created by Gottfried 

Wilhelm Leibniz.
2.	 A range of cells can be selected by dragging the mouse pointer over the cells that 

are to be selected. Or, by pressing the Shift key on the keyboard and simultaneously 
clicking on the cells that need to be selected.

3.	 One of the features of Excel is that it has a user-friendly interface with a ribbon, 
which organises commands into tabs and groups for easy access.

4.	 Emphasis category animations can highlight the selected point/object from this slide.
5.	 The Mail Merge feature in Word can be used to create and send multiple letters 

or invitations to many people at the same time. Each letter/invitation is the same, 
but it is sent to different people.

E.	 Answer the following questions.
1.	 SmartArt is a visual representation of data in a different format such as Cycle, 

Process, Lists, Hierarchy, Relationship, Matrix, Pyramid and Picture.
2.	 A page break means that a page will end and another page will be added as 

instructed by the user. The steps to insert a page break are:
•	 Click on the Layout tab.
•	 Click on the Breaks command in the Page Setup group.
•	 Select the Page option. A page break will be inserted in the document.

3.	 Some features of second-generation computers are:
•	 Second-generation computers were smaller and practical.
•	 Transistors made them faster (measured in megahertz).
•	 Programming was more user-friendly with assembly languages.
•	 Magnetic core memory improved storage.
•	 Improved input and output devices.
•	 They were used in business and science.
•	 Higher-level languages like FORTRAN and COBOL were introduced.

4.	 The steps to copy the data are:
•	 Select the cells that you want to copy.
•	 Click on the Home tab.
•	 Click on the Copy button from the Clipboard group. You can also use the 

keyboard shortcut Ctrl + C to copy the selected image.
•	 Click on the cell where you want to copy the selected range.
•	 Click on the Paste button in the Clipboard group. You can also use the keyboard 

shortcut Ctrl + V to paste the copied item.
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5.	 The steps to remove a worksheet are:
•	 Right-click on the Sheet tab that you want to remove. A pop-up menu will 

appear.
•	 Select the Delete option. A dialog box will appear.
•	 Click on the Delete option.

Test Paper 2

A.	 Tick () the correct option.
1.	 b. Boolean	 2.	 c. inbox	 3.	 c. doorbell	 4.	 c. Hat
5.	 c. Both a and b

B.	 Fill in the blanks.
1.	 Sorting	 2.	 network	 3.	 Reporter	 4.	 doorbell
5.	 Stack

C.	 Write T for True and F for False statements.
1.	 T	 2.	 F	 3.	 F	 4.	 F
5.	 F

D.	 Answer the questions in a few words.
1.	 Two smart devices are: smart speakers, smart doorbell.
2.	 The blocks that are used in Scratch are: Motion, Looks, Sound, Events, Control, 

Sensing, Operators, Variables and My Blocks.
3.	 Information can be represented in the form of tables, pictures, maps, pictograms, 

etc.
4.	 A modem is a device that connects to the computer or router to the Internet service 

provided by your ISP.
5.	 Decoding is the process of simplifying a coded message and understanding its 

meaning.

E.	 Answer the following questions.
1.	 The fields of the New Message window are: 

•	 To: In this field, we type the e-mail address of the recipient. We can type the 
e-mail addresses of multiple recipients at a time.

•	 Cc: Cc stands for Carbon Copy. By typing an e-mail address in this field, you 
can send the e-mail to a specific person, to whom you want to inform that a 
mail has been sent to the recipient in the To field.

•	 Bcc: Bcc stands for Blind Carbon Copy. By typing an e-mail address in this field, 
the recipient will know that you have sent the e-mail but the other recipients 
in To field will not be able to know that a mail has been sent to the recipient in 
Bcc field.

Galaxy_DigiVerse_Book-5_TRM.indd   27Galaxy_DigiVerse_Book-5_TRM.indd   27 05-03-2024   12:05:1605-03-2024   12:05:16



DigiVerse 528

•	 Subject: In this field we write 4-5 words to convey the purpose of the e-mail.
•	 We type the e-mail in the blank white space given below the Subject field. In 

the e-mail we can write our message in a detailed manner. 
2.	 Sorting means arranging the data by the category or type. It becomes much easier 

to understand and identify the data when it is sorted properly.
3.	 There are two types of conditional blocks in Scratch:

•	 if…then block: When a condition is true, the blocks inside the conditional block 
will be executed. If the condition is false, the blocks inside the conditional blocks 
will not be executed. Instead, only the blocks outside the conditional block  
will run.

•	 if…then…else block: If the condition is true, the blocks inside the conditional 
block will run. But if the condition is false, then the set of blocks inside the ‘else’ 
condition will be executed.

4.	 A smart speaker is a speaker with a virtual assistant that can understand voice 
commands and perform tasks independently. Some well-known smart speakers 
include Amazon Echo, Google Nest, etc.

5.	 The steps to use URLs are:
•	 Open a web browser.
•	 Type the URL in the address bar of the web browser.
•	 Press the Enter key.

1.  b.	 2.  a.	 3.  c.	 4.  c. 	 5.  a.

6.  d.	 7.  d.	 8.  a.	 9.  a.	 10.  d.

National Cyber Olympiad
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